
 

 

 

  

 
 

 Testing S-Parameters on 
Pulsed Radar Power Amplifier 
Modules 
Application Note 

 

Products: 

ı R&S
®
ZVA8 

ı R&S
®
ZVAX24 

ı R&S
®
NRP-Z211 

ı R&S
®
BBA150   

ı R&S
®
SMF100A 

 

 

This Application Note describes testing S-

parameters under pulsed conditions with the 

R&S
®
ZVA vector network analyzer.   

Two test setups are discussed here with regard to 

the source. 

▪ Using R&S
®
ZVAX24 Extension unit with 

pulse modulator option. 

▪  Using R&S
®
SMF signal generator with 

pulse modulator as a signal source. 

 

In addition a constant power level calibration for 

applications requiring high drive power for test and 

measurement of device under test (DUT) is also 

included. A LDMOS S-band radar power transistor is 

used as example DUT. The pulse profile mode of 

the R&S
®
ZVA is used to analyze the time-dependent 

behavior of the DUT. 
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1 Abstract 

 

In many cases, devices need to be characterized using pulsed signals instead of CW 

signals. Stimulation of the device is provided by either a pulsed RF signal or a pulsed 

control voltage. One examples of this method are on-wafer measurements of power 

amplifiers, where heat sinks are difficult or even impossible to implement. Another 

example is power amplifier modules for pulsed radar systems; such modules have to 

deliver high peak power and cannot be driven by CW without being destroyed. This 

Application Note describes S-parameter measurements on a radar pulsed power 

amplifier module with the ZVA vector network analyzer using a new technique, pulse 

profile mode.  

 

Two test setups have been described here extensively. In one test setup a SMR signal 

generator with pulse modulator is used as a signal source. In the second test setup, a 

ZVAX24 extension unit is used for pulse modulation. Other Rohde & Schwarz signal 

generators with a pulse-modulator option (SMR, SML, SMB, and SMA) could be used 

alternatively. The test setup and test procedure are described using an LDMOS S-

band radar power transistor as an example. See also Application Note 1MA124 for a 

general overview of pulsed measurements. 

 

The following abbreviations are used in this Application Note for Rohde & Schwarz test 

equipment:  

▪ The R&S
®
 ZVA8 Network Analyzer is referred to as the ZVA 

▪ The R&S
®
 ZVAX24 Extension Unit is referred to as the ZVAX24 

▪ The R&S
®
 NRP Z11 or higher is referred to as the Power Sensor 

▪ The R&S
®
 BBA 150 is referred to as the Power Amplifier 

▪ The R&S
®
 SMA100A signal generator is referred to as the SMA 

▪ The R&S
®
 SMB100A signal generator is referred to as the SMB 

▪ The R&S
®
 SMF100A microwave signal generator is referred to as the SMF 

▪ The R&S
®
 SML signal generator is referred to as the SML 

▪ The R&S
®
 SMR microwave signal generator is referred to as the SMR 
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Take extra precaution and check power rating of the inputs of all the 

equipments and the power at those points before connecting. This is a 

high power setup. Equipments such as power sensors, attenuators with 

insufficient power handling capabilities might be destroyed very easily. 

The internal couplers of the ZVA accessible via the port inputs are only 

designed for low powers, up to approximately 27 dBm. 
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2 General Description of S-Parameter 

Measurements with Pulse Profile Mode 

To analyze the time-dependent behavior of a device during a burst, a Vector Network 

Analyzer (VNA) has to perform a so-called “pulse profile” measurement. Typical 

parameters required to characterize the time dependent behavior include rise time, 

overshoot, and droop. A representative pulse waveform is shown in Figure 1. For this 

measurement, the VNA must have time resolution significantly higher than the pulse 

duration. A typical VNA’s time resolution ranges from 3 to 20 µs for measurements in 

the frequency or time domain, which is not great enough to analyze behavior versus 

time with sufficient resolution. Most VNAs have a measurement bandwidth of 600 kHz 

or less, which is the limiting factor for high time resolution of pulse widths of 1 µs or 

below. 

 

Figure 1 : A pulse waveform with various characteristics identified 

 

To achieve resolution of better than 1 µs, additional external hardware and software 

can be used to “chop up” the pulsed signal into slices with different timing positions 

within the pulse (Figure 2). The magnitude of these pulse slices with regard to a 

specific delay is measured and calculated in accordance with the averaged pulse 

method. The delay is then increased and the next “slices” are measured until a desired 

portion of the pulse is analyzed. This chopping can occur in either the receiver paths at 

the RF frequency or directly inside the instrument in the IF path. If the IF is chopped, 

losses incurred by the required external switches can be minimized. 
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Figure 2: An example of pulse chopping 

 

Pulse profile analysis of pulsed signals or S-parameters with pulsed stimulus is limited 

by the sampling rate of the A/D converter, the processing time between two data points 

and the available bandwidth. The sampling rate and the time required for data 

processing between two data points limit the time resolution, while the measurement 

bandwidth determines the minimum rise and fall time of the pulse that can be 

analyzed.  A new technique developed at Rohde & Schwarz employs wideband 

detection and fast data recording to greatly improve pulse profile measurements. 

 

The bandwidth-limiting factors in the analyzer are the analog bandwidth of the 

receivers and the capabilities of the digital signal processors (DSPs) for digital filtering. 

The high-end vector network analyzer R&S ZVA has an analog bandwidth of 15 MHz 

(with some performance degradation to 30 MHz). The IF filters of the DSPs offer 

adequate performance for normal CW or time sweeps with a 5 MHz bandwidth. ZVA 

receivers down convert the sampled data to the IF frequency at a sampling rate of 80 

MHz, which results in a time resolution of 12.5 ns.  

 

In addition to the sampling time, there is the data processing time between two 

measurement points, which is a bottleneck for achieving high-resolution measurements 

in the time domain. However, pulse profile measurement resolution can be dramatically 

improved by sampling the raw data and storing it directly without filtering. Instead of 

using hardware, the DSP software on the ZVA is used to perform digital down 

conversion and digital filtering after recording. The A/D converter continuously digitizes 

the data with a sampling rate of 80 MHz and writes it into high-speed RAM, which 

ensures that no delay occurs between the samples of individual measurement points, 

as shown in Figure 3. 
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Figure 3: Fast data recording made possible with the improved high-performance pulse profile 

technique (option ZVA-K7 for ZVA) 

 

Because of the high sampling rate, a measurement point is created every 12.5 ns, 

which is the time resolution. The trigger signal, usually derived from the rising edge of 

the pulse, determines the zero point in time. Consequently, the exact time relation 

between trigger detection and the incoming RF pulse can also be measured. This 

relation is especially important for determining the correct trigger delay in point-in-pulse 

measurements versus frequency or level.  

The ZVA performs extremely-fast pulsed measurements, and with more than 10 

sweeps per sec at 1001 test points, devices can easily be adjusted during the pulse 

profile measurement.  

In addition to periodic single-pulsed signals, this new technique handles double pulses, 

as well as user-defined pulse trains. Devices stimulated using pulses with frequency 

and amplitude modulation, such as chirps, can also be analyzed. 

 The new techniques also benefit measurement of the S-parameters of devices with 

group delays in the order of the pulse width, which has been difficult or even 

impossible up to now. The stimulated RF signal may no longer be present at the 

device’s input by the time the VNA receives the transmitted RF signal from the output.  

A correct S21 parameter can only be measured with temporal signal overlapping. 

Using the new technique, the VNA solves this problem by applying a time offset to the 

wave quantities. Before calculating the S-parameters, it mathematically shifts the wave 

quantities by the device’s group delay. A specific time delay can be assigned to each 

wave quantity depending on the measurement direction, so the VNA correctly displays 

the gain (S21) versus the entire pulse duration. 
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3 Point in Pulse Measurement 

The point-in-pulse measurement enables accurate S-parameter and power 

measurements to be made, allows the moment of data acquisition within the pulse to 

be easily shifted, and eliminates the dependency of dynamic range on duty cycle. 

However, it requires a VNA with a wide measurement bandwidth. Using the point-in-

pulse measurement technique, the pulse is monitored only during the “on” phase of the 

RF bursts so the sampling time (Tspl) to acquire the raw data of a wave quantity or an 

S-parameter must be shorter than the pulse width, ton (Figure 4). 

 

Figure 4: Sampling time for point-in-pulse measurements 

 

The sampling time is determined mainly by the receiver’s measurement bandwidth, 

and minimum sampling time and measurement bandwidth is defined as Tspl 1/IFBw. 

This means that with increasing measurement bandwidth, sampling time decreases 

and shorter pulses can be analyzed. VNAs implement IF filters digitally and typically 

offer measurement bandwidths up to 600 kHz, so the sampling time is 1 µs or more. 

Some network analyzers, such as the R&S ZVx Series, have IF bandwidths of 5 MHz 

or more, which allows sampling times as fast as 400 ns with a 5 MHz bandwidth. The 

sampling process should only occur during the on-phase of the pulse, so a trigger 

signal synchronous to the RF pulse is necessary to synchronize the data acquisition of 

the VNA with the on-period of the pulse. The VNA is used in “point-trigger mode”, 

which means that data sampling for every measurement point starts after the detection 

of a trigger event. 

Active devices such as amplifiers often show settling or ringing effects at the beginning 

of the pulse, but designers are typically interested in device behavior after it has 

settled. By selecting a suitable trigger delay, the start of the sampling process can be 

shifted to the quiet pulse roof of the amplifier. Dynamic range and sensitivity using the 

point-in-pulse method depends on sensitivity and the measurement bandwidth of the 

receivers, which are independent of the duty cycle of the RF pulse. Consequently, 

dynamic range depends on pulse width, which determines sampling time and thus the 

required measurement bandwidth. Averaging can be applied to increase dynamic 

range by maintaining the measurement bandwidth. Ten times averaging in the IQ 

domain (for example) increases the dynamic range by a factor of 10. 
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4 High-Power Transistor Test Setup 

 

The DUT used in our application note is an S - Band LDMOS Pulsed Radar Power 

Transistor in an RF test fixture with N connector. 

 

Condensed  data of the NXP BLS7G279L - 350P LDMOS S-Band pulsed radar 
power transistor 

 

Frequency range 

  

2.7 GHz to 2.9 GHz 

 

 

Output  Power  

 

350 W 

At a duty cycle of 10% and 300 µs 
pulse width. 

 

Gain  

 

13.5 dB 

 

 
Table 1: Condensed data of the DUT (NXP BLS7G279L - 350P LDMOS S-Band Pulsed Radar 

Power Transistor 

 

 

Device Under Testing NXP BLS7G279L - 350P LDMOS S-Band Pulsed Radar Power Transistor 
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4.1 Test Setup using SMF (Signal Generator) 

 

The internal couplers of the ZVA accessible via the port inputs are only designed for 
low powers up to approximately 27 dBm. Figure 5 shows the test setup in detail. The 
pulsed output signal of the SMF is amplified to the required drive power by a power 
amplifier operating in linear mode. Part of the input power and of the reflected power of 
the amplifier module under test (DUT) is coupled by a bidirectional coupler and 
reduced by attenuators (20 dB) to the levels suitable for the ZVA reference and test 
inputs. The DUT output is connected to a 30 dB power attenuator. A part of the 
attenuated output signal is coupled by the directional coupler and fed via another 10 
dB attenuator to port 2 of the ZVA. 
  

 

 

Figure 5: Test setup for characterizing radar pulsed power transistor with the ZVA and SMF 

 

The Sync output of the SMF triggers the ZVA for pulse-synchronous analysis. The 
SMF also provides a 10 MHz reference signal for the ZVA in order to eliminate 
frequency deviations between the SMF transmit signal and the ZVA receive signals. 
The ZVA must therefore be set to external reference. 
 

In the case of unavailability of an SMF signal generator, the same test setup is 

possible using the ZVAX24 Extension Unit. In this Application note, we discuss in detail 

the test setups and the test results obtained using the ZVAX24 Extension unit. 
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4.2 Test Setup using ZVAX24 (Extension Unit) 

 

Due to the high drive power required (approx. 22 W) and the considerably higher 

output power (approx. 350 W), a test setup with external couplers is necessary. The 

internal couplers of the ZVA accessible via the port inputs are only designed for lower 

powers up to approximately 27dBm.  

 

Figure 6: Test setup for characterizing radar pulsed power transistor with the ZVA and ZVAX24 

 

 

Figure 6 shows the test set up in detail. The pulsed output signal from the extension 

unit is amplified to the required drive power by a power amplifier operating in the linear 

mode. Part of the input power and of the reflected power of the amplifier module under 

test (DUT) is coupled by a bidirectional coupler and reduced by attenuators (36 dB) to 

the levels suitable for the ZVA reference and test inputs. The DUT output is connected 

to a 30 dB power attenuator. A part of the attenuated output signal is coupled by the 

directional coupler and fed via another 10 dB attenuator to port 2 of the ZVA. 
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5 Pulse Profile Measurement 

5.1 Measurement Principle 

 

The pulse modulator option R&S ZVAX24 provides a pulsed source signal at the VNA 

port 1. Pulse width and period are determined by the internal pulse generator of the 

VNA provided by option R&S ZVAB27. This option also provides a second “Sync” 

signal that can be used to synchronize the measurement to the rising edge of a 

generated pulse. 

 

The DUT is connected between the test port 1 and test port 2 of the analyzer. The 

transmitted pulsed signal is measured at port 2 using the analyzer’s “Pulse Profile” 

mode. 

  

The measurement involves the following steps, 

1. Connect the ZVAX24 extension unit.  

2. Configure the extension unit for the selected measurement and test setup (“ZVAX 

Path Configuration”). 

3. Define of the pulse generator and the trigger setting. 

4. Configure of the “Pulse Profile” mode. 

5. Calibrate (Power calibration and system error calibration). 

6. Connect the DUT and perform the measurement. 

 

Power calibration and system error correction for test setups with the extension unit 

can be performed in the ordinary way. However, care must be taken while connecting 

the power sensor.  

 

 

 

The input power rating of every device must be taken in account since this is a high 

power measurement setup. 
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Connecting the ZVAX24 Extension Unit 

 1MA126_2E   Rohde & Schwarz  Testing S-Parameter on Pulsed Radar Power Amplifier Module  13 

5.2 Connecting the ZVAX24 Extension Unit  

 
The pulse profile measurement requires the following connection between the network 
analyzer and the extension unit.  
 

▪ RF connection: Connect SOURCE IN (ZVAX) to SOURCE OUT (ZVA) and 

SOURCE OUT (ZVAX) to RF-IN (BBA150). 

 

▪ Control Connection: Connect USB from NWA (ZVAX) to any of the USB type 

A connectors at the front and rear panel of the ZVA. 

 

▪ Pulse Generator Connection: Connect CASCADE IN (ZVAX) to CASCADE 

(ZVA) using the RJ - 45 cable supplied with the extension unit. 

5.3 ZVAX Path Configuration 

 
After the extension unit is connected to the network analyzer as described in the 
previous section, it is possible to select the modules to be looped into the signal 
path(s) and the routing of the pulse generator signals. This is done in the “ZVAX Path 
Configuration” dialog (“Channel>Mode>ZVAX Path Configuration”). The schematic in 
this dialog shows all RF modules that are installed in the extension unit. 
 

 

Figure 7: ZVAX Path Configuration 

 



Pulse Profile Measurement  

 
Setting up the pulse profile mode of the ZVA 
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Figure 8: ZVAX Path Configuration (Pulse Generator) 

 
 

a) Use the radio buttons in the “ZVAX Path Configuration” dialog to activate the 

“Source 1 Pulse Modulator”. If your extension unit contains a harmonic filter 

or combiner, select the corresponding Through paths (Figure 7). 

b) Press “Pulse Generators” and make sure that the “Modulator Source” and the 

“Modulator Assignment” settings are as shown in Figure 8.  

 

5.4 Setting up the pulse profile mode of the ZVA 

 
The dialog box for setup of ZVA pulse profile mode parameters are shown in Figure 9.  
 
Start and stop time parameters are set to -3 µs and 35 µs (recording length is thus 38 
µs) to center the pulse with in the display. The bandwidth is set to 10 MHz for fast time 
response. Source power is set to -60.7 dBm. But this is automatically set when we 
input the channel base power as -60.7 dBm. The center frequency is set to 2.8 GHz 
since the working range of the DUT is specified between 2.7 GHz – 2.9 GHz. 
 
 
1. Click "Channel > Sweep > Sweep Type > Pulse Profile" to activate the pulse profile 
mode. 
 
2. Click "Define Pulse Profile" and configure the "Time Parameters" as stated  



Pulse Profile Measurement  

 
Pulse generator signals 
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Figure 9: Pulse profile parameter setting 

 
Number of points can be selected as desired. 
 
Define Pulse Profile adjustment is done to define what is seen of the screen of the 
ZVA. The time parameters can be altered to zoom into certain parts the pulse.  For 
example, the start and stop time can be adjusted to -3 µs to 8 µs for displaying just the 
beginning of the pulse. 
 

5.5 Pulse generator signals 

 
The pulse generator provides single pulses with defined width and period or 
sequences of pulses (pulse trains). For our test setup we use the option “Single Pulse”. 
A single pulse with a width of 30 µs is generated. The pulse is repeated after a pulse 
period of 300 µs.  
 

 

Figure 10: Pulse profile parameter setting 



Pulse Profile Measurement  

 
Setting up the pulse modulation of the SMF 
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Define Pulse Generator adjustment defines the parameter of the pulse that is 
generated.   
 
1. Click "Channel > Sweep > Sweep Type > Pulse Generator" to activate the pulse 
generator signal.  
 
2. Click "Def Pulse Generator" and configure the "Pulse Parameters" as shown above.              
 
3. In the "Define Pulse Generator" dialog, click "Define Sync Generator..." and ensure 
that the "Sync" signal is configured as shown below. 
 
4. Click "Channel > Sweep > Trigger > Pulse Gen..." to select the pulse generator as 
trigger source. The dialog "Pulse Gen Trigger" opens. Close it without modifying the 
default setting ("Rising Edge Sync"). 
 
 
 

5.6 Setting up the pulse modulation of the SMF 

Setup the pulse modulation parameters for the SMF as shown in Figure 11. 
Pulse period and pulse width are in accordance with the specifications of the power 
amplifier module under test. 
 

 

Figure 11: Pulse modulation parameter setting of the SMF 



Calibration  

 
One Path Two-Port Calibration of Test Setup 
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6 Calibration 

Calibration is one the major steps in any test and measurement setup. The 

requirement of the constant power level is fulfilled by the proper power calibration on 

source and receiver test port. And for the compensation of system related errors, the 

calibration for system error correction is a must. Figure 12 and Figure 13 shows the 

test setups for testing and measurement purpose of high drive power requirement 

applications. 

6.1 One Path Two-Port Calibration of Test Setup 

The calibration of the ZVA is performed in the pulse profile mode. The module under 
testing is removed and the two associated ports are the calibration plane.  
 

 

Figure 12: Calibration Setup for Characterizing a Radar Pulsed Power Transistor with the ZVAX24 

 

 
 

Figure 13: Calibration Setup for Characterizing a Radar Pulsed Power Transistor with the SMF 
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Due to the needed high pulse power of the device under test and the corresponding 
high attenuation between the amplifier’s output and port 2 of the network analyzer, 
noise during the calibration of S21 is increased and then superimposed on the 
subsequent measurement. This effect can be considerably reduced by decreasing the 
measurement bandwidth to 100 KHz for calibration.  
 
For measurement on the DUT, restore the original 10 MHz measurement bandwidth. 
Three types of calibration were performed in total. First the source power calibration is 
performed to achieve constant linear power at the source test port. The receiver power 
calibration is performed next. This is done to make the source and the receiver 
resemble each other. And finally the one path two-port calibration is performed as a 
system error correction procedure. 
A detailed description on how to perform each individual calibration is provided later in 
this application note. 
 

The following measurements are obtained using a through connection between 

the test ports at the calibration plane.  

 

Figure 14 shows the magnitude plot of the incident wave at port 1 (a1) and the 

magnitude of reflected wave of port 2 (b2). Both the traces are in the dBm scale. The 

markers M1, M2 and M3 are placed at 2.1 µs, 8.2µs and 29.06µs. Coupled markers 

are used here. The time scale used can be defined in the dialog “Define Pulse Profile”.  

To do that, the sweep type Pulse Profile must be activated first. The pulse period for 

this particular DUT is 300µs at 10% duty cycle. So the pulse width is set as 30µs from 

the pulse generator.  

 

Figure 14: Single Path Two port calibration of test setup. The magnitude plot for a1 and b1 for the 

entire pulse duration. 
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Figure 15 shows the magnitude plot of input complex reflection coefficient (S11) and 
the forward complex transmission coefficient (S21). The green trace is S11 and the red 
trace is S21. 
 

 

Figure 15: Single Path Two port calibration of test setup. The magnitude of S11 and S21 for the total 

pulse width.  

 

Figure 16 shows the magnitude and the behavior of the phase plot of S21 during the 

total pulse width of 30 µs. 

 

Figure 16: Single Path Two port calibration of test setup. The magnitude and phase plots of S21 for 

the total pulse width. 
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Figure 17 is a collaborative plot of the previous plots in one screen for easy 

comparison of measurement data. 

  

Figure 17: Single Path Two port calibration of test setup. The noise of S21 can be reduced by 

reducing the measurement bandwidth to 100 KHz during calibration. 

 

Figure 18 shows in detail the magnitude plot of S11 and incident and reflected waves 
a1 and b1. 
 

 

Figure 18: Single Path Two port calibration of test setup. The magnitude S11, the wave quantity a1 

and b1 for the total pulse width. 
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6.2 Power calibration 

Since this is a high power setup, linearity in the output of the driver amplifier is 

required. The power calibration in this case becomes highly important and forms a very 

significant part of the entire test and measurement procedure. After all connections are 

made as shown in the test setup (Figure 12 or Figure 13), the calibration is carried out 

at the calibration plane. 

  

 

Power Sensor with 30dB Attenuator (used for power sensor protection) 

 
A 30 dB input attenuator is placed in front of the power sensor and the input source 
test port. The input power rating of the attenuator for our case is 100W. For the 
purpose of our DUT testing we require up to maximum 30 W (44dBm) input power. The 
purpose of attenuator is to protect our power sensor. We are using a Rohde & Schwarz 
NRP-Z211 two-path diode sensor (-60 dBm to +20dBm). 
 
For this application note a BBA150-D60 Broadband Amplifier was used. The BBA150-
D30 can also be used even though not recommended. The BBA150-D30 has its 1dB 
compression point at 38W in the 2.7GHz to 2.9GHz frequency range and hence may 
involve a small compromise in drive signal linearity. We will calibrate so that at the 
input of the DUT there is a constant power of 43.3 dBm for the frequency span of 
2.5GHz to 3GHz. The DUT’s operating frequency range is 2.7 GHz to 2.9 GHz. 
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6.2.1 Source Power Calibration 

Step 1 ZVA configuration for Power Calibration  
(Switch off power amplifier)  
 
Connect the power sensor to the USB of the ZVA. 
 

Setting power limit 
System > System Config. > Power 

 

Figure 19: Calibration settings 

 
 
 
Channel base power setting:  

Channel > Power Bandwidth Average > Power > -60.7 dBm 

 
 
Step Attenuator Setup 

Channel > Power Bandwidth Average > Step Attenuator > 

 

Figure 20: Calibration settings 

Measurement Bandwidth Selection (Lower noise of S21) 
Channel > Power Bandwidth Average > Meas Bandwidth > 100KHz 
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Number of points (For faster calibration) 
Channel > Sweep > No of points > 11 or 21 

 
It is recommended to perform option 1 and then again option 2 if tests on the DUT are 
carried out in Pulse Profile Mode. 
 
Sweep type  
Option 1 (Linear Sweep) 
Channel > Sweep >Sweep Type > Lin Frequency  
 
Start Freq: 2.5 GHz 
Stop Freq: 3 GHz 
 
Pulse Generator Activation 
Channel > Mode > Pulse Generator 
 
 
Pulse Gen. Setup  
Channel > Mode > Def Pulse Generator 

 

Figure 21: Calibration settings 

 
Option 2 (Pulse profile) 
Channel > Sweep >Sweep Type > Pulse Profile 
Channel > Sweep >Sweep Type > Define Pulse Profile 
 

  

Figure 22: Calibration settings 
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Pulse Generator Activation 
Channel > Mode > Pulse Generator 
 
 
Pulse Gen. Setup  
Channel > Mode > Def Pulse Generator 
 
The pulse train with Pulse Train Period 300µs can also be selected. 
 

 

Figure 23: Calibration settings 

 
 
Common for both Option 1 and Option 2 
 
Trigger Settings 
Channel >Sweep >Trigger > Pulse Gen 

 

Figure 24: Calibration settings 
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External Power Meter Configuration 
System > System Config> External Power Meters (automatic detection and config.) 
 

 

Figure 25: Calibration settings 

 
Power Calibration  
Channel > Calibration > Power Corr All Ports On (Tick sign appears after activation) 
 
Source Power Calibration 
Channel > Calibration > Start Power Cal > Source Power Cal  
 
Modify Source Power Cal. Setting  
Click Modify settings 

 

Figure 26: Calibration settings 
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For this step we have to manually insert the value of Offset and Cal Offset. Click on the 
drop down box for Atten and select Low Noise Amplifier. The Cal Offset is set to a 
value higher than the gain of the amplifier and the offset value is adjusted so that the 
Cal Pwr is 43.3 dBm. 
 

For hand calculation: 

Pb + Offset + Cal Offset = Cal Pwr (-60.7+39+65=43.3 dBm) 

Pb = Channel base power (it is set automatically from previous steps) 

For higher accuracy in the power calibration process we recommend using:  

Maximum Number of reading: any value greater than 5. 

Tolerance: 0.1 dB 

Convergence Factor is set to a value less than 1. 

Recommended settings:  

Select both Flatness Cal and Reference Receiver Cal.  
Also select Use Reference Receiver After. And select a value greater than 1 for power 
meter reading. 
 
Figure 26 shows the setting used in this application note for test and measurement on 
our DUT.  For your application we suggest you tryout other values and select a suitable 
setting for your application. 
 

 

Power Meter Correction 
Add Point > 2.5 GHz > -36 dB Transmission Coef. 
Add Point > 3 GHz > -36 db Transmission Coef. > OK 

 

Figure 27: Calibration settings 
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Switch on power Amplifier (allow for warm up time) 
 

 

Figure 28: Calibration settings 

Click Take Cal Sweep 
 
For ideal source power calibration we can expect a constant flat line at 43.3 dBm with 
little swing (typically 0.2 dB).  
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6.2.2 Receiver power calibration 

Make a through connection between the Source Test Port and the Output Test Port at 
Calibration Plane 
Channel > Calibration > Start Power Cal > Receiver Power Cal 
 
 

 

Figure 29: Calibration settings 

Click Take Cal Sweep 

 

Remove the Power Sensor and Input Attenuator (30 dB) from the test port. 
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6.2.3 Calibration for System Error Correction  

Channel > Calibration > Start Cal > Two Port P1-P2 > One Path Two-port 

 

Figure 30: Calibration settings 

 

Click Next.  

Perform the normal calibration procedure. For our purpose we are using N-port ZCAN 

calibration Standard. 

Open, Short, Match and Through. 

 
The entire calibration process is now complete. Now connect the test ports to 
the DUT. And the setup up is ready for test and measurements.  
(Figure 5 or Figure 6) 
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7 Test Results 

The following test results are derived from the pulsed profile measurements carried out 

on an LDMOS S-band radar power transistor (BLS7G2729L- 350P) as DUT. The 

frequency on interest is within the range of 2.7GHz and 2.9GHz. The center frequency 

is to 2.8 GHz. The measurement bandwidth is set to Fine Adjust. The pulse profile 

mode is activated. The pulses are of 300µs period at 10% duty cycle. Pulse width is 

thus set to 30 µs. 

 

Figure 31 shows the combined general plot of the DUT test setup under Pulse Profile 

measurement. There are 4 diagram areas on the same channel. To add a new 

diagram area Trace > Trace Select > Add Trace + Diag Area 

 

 
Figure 31: Test results of the pulse profile measurement (general) 
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Figure 32 shows the behavior of the S11 parameter using Smith Chart output. To 
activate the Smith Chart plot, Trace > Format > Smith. 
 
To get a detailed view of one diagram area (Figure 32) instead of a combined general 
screen view of all the diagram areas (Figure 31), double click anywhere on the diagram 
area of interest. Next, using the toolbar click on Trace > Measure > S11. The front 
panel can also be used instead. 
 
 

 

Figure 32: Test results of the pulse profile measurement. The smith chart plot of S11. 

 
 
 
Figure 33 shows the magnitude of S11, b1 and a1 for the total duration of the pulse 
width.   
Markers data can be moved from the top right to any place on the screen. Right click 
on the marker data and select moveable marker data. Now reposition at your own 
convenience. 
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Figure 33: Test results of the pulse profile measurement. The magnitude of S11, magnitude of wave 

quantities b1 and a1 for total pulse width. 

 

Figure 34 shows the magnitude plot for incident wave quantities a1 and b2 for source 
at port 1 of ZVA. 
For the measurement of wave quantities, click Trace>Measurement>Wave Quantities 
> a1. For adding a second trace in the same diagram area Trace> Add Trace. 
Next, Trace>Measurement>Wave Quantities > b1 

 
 

Figure 34: Test results of the pulse profile measurement. The magnitude of a1, magnitude of b2 for 

total pulse width. 
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Figure 35 shows the gain and output power measurement for the total duration of the 

pulse width.  For changing the scaling in the dB axis for individual traces 

Trace>Scale>Scale / Div. In Figure 35 we selected Scale per division of 1 dB in order 

to increase precision and sensitivity of the measurements. 

 

Figure 35: Test results of the pulse profile measurement. The magnitude of S21, magnitude of b2 for 

total pulse width. 

 

Figure 36 shows the Gain and Output Power measurements results over the operating 

frequency range. 

 

Figure 36: Test results of the pulse profile measurement over the operating frequency range. 
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Figure 37 shows the behavior of the phase of S21 over the total pulse width of 30µs.   

 
Figure 37: Test results of the pulse profile measurement. Phase measurement of S21 for total pulse 

width.  

 

Figure 38 shows the behavior of S21 in terms of phase and magnitude. 

 
Figure 38: Test results of the pulse profile measurement. The magnitude and phase of S21, 

magnitude of wave quantities b2 total pulse width. 



References  

 
 

 1MA126_2E   Rohde & Schwarz  Testing S-Parameter on Pulsed Radar Power Amplifier Module  35 
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9 Ordering Information 

Please note that a complete range of network analyzers, power amplifier, power 
sensor and power meter is available from Rohde & Schwarz.  
For additional information about these instruments, see the Rohde & Schwarz website 
www.rohde-schwarz.com or contact your local representative. 
 

 Product Ordering Information 

Type of instrument Designation and range Order No. 

Vector Network Analyzer 

R&S
®
 ZVA 8* Vector Network Analyzer, 300 

KHz..8GHz, 4 Port 
1145.1110.10 

R&S
®
 ZVA-K7 Pulsed Measurements 1164.1511.02 

R&S
®
 ZVA-K27 Pulse Generator 1164.1892.02 

R&S
®
 ZVA8-B16 Direct Generator/Receiver  

Access for the R&S
®
 ZVA 8. 

1164.0209.08 

R&S®ZVA8-B21 Generator Step Attenuator Port 1 1164.0009.02 

R&S®ZVA8-B22 Generator Step Attenuator Port 2 1164.0015.02 

R&S®ZVA8-B23 Generator Step Attenuator Port 3 1164.0021.02 

R&S®ZVA8-B24 Generator Step Attenuator Port 4 1164.0038.02 

R&S®ZVA8-B31 Receiver Step Attenuator Port 1 1164.0044.02 

R&S®ZVA8-B32 Receiver Step Attenuator Port 2 1164.0050.02 

R&S®ZVA8-B33 Receiver Step Attenuator Port 3 1164.0067.02 

R&S®ZVA8-B34 Receiver Step Attenuator Port 4 1164.0073.02 

Extension Unit 

R&S
®
 ZVAX24 Extension Unit, 10 MHz.. 24GHz 

 
1311.2509.02 

R&S® ZVA-B271 Pulse Modulator Source Port 1 1311.2573.02 

R&S® ZVA-B272 Pulse Modulator Receiver Port 2 1311.2508.02 

R&S® ZVA-B273 Pulse Modulator Source Port 3 1311.2596.02 

 Power Sensor and Power Meter 

R&S
®
 NRP-Z211* Two-Path Diode Sensor, 

10MHz … 18GHz, -60dBm… 
+20 dBm 

1417.0409.02 

R&S
®
 NRP Power Meter 1143.8500.02 

R&S
®
 NRP-Z4 USB Adapter(Passive) 1146.8001.02 

Broadband Power Amplifier 

R&S
®
 BBA150-D60* Broadband Power Amplifier 5355.9004K40 

Signal Generator    

R&S®SMF100A* Microwave Signal Generator 1167.0000.02 

R&S®SMF-K3 Narrow Pulse Modulation 1167.7804.02 

R&S®SMF-K23 Pulse Generator  

 

http://www.rohde-schwarz.com/
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* Other ZVA, Power Sensor, Power Meter and Amplifier models are available as well. 

More Options are available. The instrument's minimum configuration for this application 

is shown in the table. Please ask your local representative for a suitable configuration 

according to your needs. 

 

 

 

 

 

 

 

 

 

 



 

 

 
 

 About Rohde & Schwarz 

Rohde & Schwarz is an independent group of 

companies specializing in electronics. It is a leading 

supplier of solutions in the fields of test and 

measurement, broadcasting, radio monitoring and 

radiolocation, as well as secure communications. 

Established more than 75 years ago, Rohde & 

Schwarz has a global presence and a dedicated 

service network in over 70 countries. Company 

headquarters are in Munich, Germany. 

 

 Regional contact 

Europe, Africa, Middle East 
+49 89 4129 12345 
customersupport@rohde-schwarz.com  
 
North America 
1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com  
 
Latin America 
+1-410-910-7988 
customersupport.la@rohde-schwarz.com  
 
Asia/Pacific 
+65 65 13 04 88 
customersupport.asia@rohde-schwarz.com 

China 
+86-800-810-8228 /+86-400-650-5896 
customersupport.china@rohde-schwarz.com 
 

Environmental commitment 

ı Energy-efficient products  

ı Continuous improvement in environmental 

sustainability 

ı ISO 14001-certified environmental 

management system 

  

 

 

This  and the supplied programs may only be used 

subject to the conditions of use set forth in the 

download area of the Rohde & Schwarz website. 

 

R&S
®
 is a registered trademark of Rohde & Schwarz GmbH & Co. 

KG; Trade names are trademarks of the owners. 

 

Rohde & Schwarz GmbH & Co. KG 

Mühldorfstraße 15 | D - 81671 München 

Phone + 49 89 4129 - 0 | Fax + 49 89 4129 – 13777 
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